
Basic Operation Guide
for Polygon Editing Tool



Safety Symbols
The following symbols are used in this manual to prevent accidents which may occur as result of incorrect use of the
instrument.

Notes on this Manual
• This software can be used with KONICA MINOLTA SENSING’s VIVID series of 3-D digitizers (VIVID 910, 900, 700, and

300). This manual explains how to use the software with the VIVID 910 digitizer.
• The VI-910, VI-900, VI-700, VI-300 are model names for Europe and VIVID 910, VIVID 900, VIVID 700, VIVID 300 are

model names for other countries. The VIVID (VI) series digitizer includes VIVID 910 (VI-910), VIVID 900 (VI-900), VIVID
700 (VI-700), and VIVID 300 (VI-300).

• This manual gives brief explanations of basic commands only. For more details of the basic and other commands, refer to the
Polygon Editing Tool Instruction Manual.

• Copying or reproduction of all or any part of the contents of this manual without KONICA MINOLTA SENSING’s permission
is strictly prohibited.

• The contents of this manual are subject to change without prior notice.
• Every effort has been made in the preparation of this manual to ensure the accuracy of its contents. However, should you have

any questions or find any errors, please contact a KONICA MINOLTA SENSING authorized service facility.
• KONICA MINOLTA SENSING will not accept any responsibility for consequences arising from the use of the instrument.
• Company names and product names which appear in this manual are their trademarks or registered trademarks.
• Contents and display examples given in this manual are subject to change.
• The name MINOLTA or MINOLTA CO., LTD and its associated logo used in this manual (or on the product or any included

materials) has been superseded by the new name KONICA MINOLTA or KONICA MINOLTA SENSING, INC.

Denotes a sentence regarding safety warning or note.
Read the sentence carefully to ensure safe and correct use.

Denotes a prohibited operation.
The operation must never been performed.

Denotes an instruction.
The instruction must be strictly adhered to.

Denotes a sentence regarding safety precaution for laser.
Read the sentence carefully to ensure safe and correct use.



Safety Precautions
When using this software, the following points must be strictly observed to ensure correct and safe use.
After you have read this manual, keep it in a safe place so that it can be referred to easily whenever it is needed.

Software Restrictions
• Copying or reproduction of all or any part of the contents of this software and manual without KONICA MI-

NOLTA SENSING’s permission is strictly prohibited.
• The specifications of the software are subject to change without prior notice.
• KONICA MINOLTA SENSING will not take any responsibility for damage caused as result of use of this

software.

Notes On Use
• When inserting a CD-ROM into the CD-ROM drive, make sure that it is placed straight in the right direction,

and inserted gently.
• Keep the CD-ROM clean.  If it becomes dirty, a reading or writing error may result.
• Pay attention to rapid temperature changes and dew condensation.
• Keep the CD-ROM away from direct sunlight or heaters.
• Do not let the CD-ROM drop or be exposed to strong shocks.
• Keep the CD-ROM away from water, alcohol, thinner etc.

Notes On Storage
• Do not store the CD-ROM in a hot area, for instance, in direct sunlight or near heaters.

To ensure correct and safe use of this software, please read the instruction manuals of the VIVID
(VI) series digitizer and personal computer in addition to this manual before operating. Incorrect
operation of the software may result in fire or electric shock. 

Never stare into the VIVID 910’s laser emitting window. 

Do not place a lens, mirror or optical element in the passage of the laser beam from VIVID 910.
Doing so may converge the laser beam, resulting in damage to your eyes, burns or fire. To prevent
the above accidents, make sure that a wall or similar which can block the laser beam is located
behind the object.

WARNING Failure to adhere to the following points may
result in death or serious injury.
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Flow of Operations
Operation flow of the Polygon Editing Tool is shown below.

Step 3 Selecting the Item to be 
Processed/Edited

First, you need to import image data.

Selecting a digitizer ........................................ 6 page
One Scan ....................................................... 7 page
Step Scan ...................................................... 9 page
Opening a Saved Data File............................ 12 page

etc.

Step 1 Importing Image Data

This section explains how to change the way elements 
are displayed to facilitate selection of points and 
processing/editing of data. 

Displaying Points ........................................... 13 page
Zoom .............................................................. 14 page
Orbit ............................................................... 15 page
Switching the Rendering Mode....................... 16 page

etc.

Step 2 Changing the Element View 
Mode

Select the element or points of the data to be processed/edited.
Selecting an Element ..................................... 17 page
Displaying Points ........................................... 18 page
Canceling the Selected Points ....................... 19 page
Reversing the Selection state of Points...........19 page
Selecting Points within the Specified 
Rectangle Area ............................................... 20 page

etc.



Flow of Operations
This manual gives brief explanations of basic commands only. For more details of the basic and other commands,
refer to the Polygon Editing Tool Instruction Manual.

Save the imported data and processed/edited elements.

Saving Elements ............................................ 26 page
Saving a Scene .............................................. 27 page
Converting to Other Formats...........................28 page

etc.

Step 5 Saving Data

Process/edit the selected element.

Deleting Points .............................................. 21 page
Performing Registration of Elements ............. 22 page
Merging Elements .......................................... 24 page
Undo .............................................................. 25 page
Redo .............................................................. 25 page

etc.

Step 4 Processing/Editing Data

Ref.
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Importing Image Data
This section explains how to Import the data to be processed, edited or saved using the Polygon Editing Tool.

Selecting a digitizer
Select the VIVID connected to the computer so that it can be controlled via this software.

For details of the File – Select Digitizer command, refer to page 99, in the Polygon Editing Tool Instruction Man-
ual.

[Operating Procedure]

1 Click [Select Digitizer] on the [File] menu.
The [File-Select Digitizer] dialog box will appear, showing the currently selected digitizer

Memo

The first time you open this dialog box after installing this software, the box will display “None.” Once you have
selected a digitizer, this box will indicate your selection.

2 Select the digitizer you want to use, and click
the [OK] button.
The selected digitizer can be controlled via the menus
that appear when File – Import – Digitizer is selected.

Memo

If a digitizer has already been selected and you switch it to
another digitizer, the new digitizer will be usable when this
software is started next time.

Ref.



Importing Image Data
One Scan
To scan images by one shot at a time controlling the VIVID 910 via the computer, follow the procedure given
below.

Never stare into the laser emitting window. 
Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may con-
verge the laser beam, resulting in damage to your eyes, burns or fire. To prevent the above acci-
dents, make sure that a wall or similar which can block the laser beam is located behind the object.

For details of the File – Import – Digitizer – One Scan command, refer to page 54, in the Polygon Editing Tool
Instruction Manual.

[Operating Procedure]

1 From the [File] menu, select [Import], [Digitiz-
er] and then [One Scan].
The [File-Import-Digitizer-One Scan] dialog box will
appear.

2 Set an object in place.
A monochrome image taken by the VIVID 910 will ap-
pear in the Image area of the dialog box.

3 To display the object in the middle of the window, change the position of the object or
move the instrument back and forth to change the view angle.

Note

If the object is not positioned in the middle of the window, it may not be scanned properly.

4 To view the color image, click the [Color] but-
ton.
A color image taken by the VIVID 910 will appear in
the Image area of the dialog box.

Note

If the distance or angle to the object has been changed,
click the [Mono] button to display the monochrome image
to check it.

Ref.
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Importing Image Data
5 Select a scan mode.
In the [Camera1] tab page, click the [Fine] or [Fast] radio button.

<Settings>
• Fast: Scans the image in approximately 0.3 seconds. However, the number of pixels will drop to approximately

1/4 of that taken in Fine scan mode.
• Fine: Produces an image with a resolution of 640 × 480.

6 From the [General] tab, click the [Scan] but-
ton.
Scan will start, and both color and range images will be
displayed.

7 Click the [Convert] button.
The [Remote-Convert] dialog box will appear.

8 Enter the desired element name and click the
[OK] button.
The scanned image will be displayed.

Note

The element name must consist of up to 31 alphanumeric
characters.

• If the [Save CDM] checkbox is checked, the
[Remote-Save] dialog box will appear.
1 Enter a file name.
2 Click the [Save] button.

Note

The file name must consist of alphanumeric characters only.



Importing Image Data
Step Scan
To scan two or more images of the same object from different angles while controlling the VIVID 910 and op-
tional turntable, follow the procedure given below.

Never stare into the laser emitting window. 
Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may con-
verge the laser beam, resulting in damage to your eyes, burns or fire. To prevent the above acci-
dents, make sure that a wall or similar which can block the laser beam is located behind the object.

Memo

To perform step shot scan using the rotating stage, connect the stage to the computer, turn ON the power to the stage and
check that the stage is recognized by the computer.

For details of the File – Import – Digitizer – Step Scan command, refer to page 59, in the Polygon Editing Tool
Instruction Manual.

[Operating Procedure]

1 From the [File] menu, select [Import], [Digitiz-
er] and then [Step Scan].
The [File-Import-Digitizer-Step Scan] dialog box will
appear.

2 Place the object on the rotating table.
A monochrome image taken by the VIVID 910 will ap-
pear in the Image area of the dialog box.

3 To display the object in the middle of the win-
dow, change the position of the object or
move the instrument back and forth to change
the view angle.

Note

If the object is not positioned in the middle of the window,
it may not be scanned properly.

4 To view the color image, click the [Color] button.
A color image taken by the VIVID 910 will appear in the Image area of the dialog box.

Note

If the distance or angle to the object has been changed, click the [Mono] button to display the monochrome im-
age to check it.

Ref.
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Importing Image Data
5 Open the [Hardware] tab page, and select the desired rotation step for the turntable.
<Settings>
• 90: Scans the object at every 90 degrees (four times in total).
• 60: Scans the object at every 60 degrees (six times in total).
• Other: Allows you to specify the desired rotation step.

Memo

If [Angle] is not active, the rotating stage is not recognized correctly by the computer.

Tip
If the rotating stage is not recognized correctly by the computer, carry out the following procedure.
1. In the [Hardware] tab page, select the COM port to which the rotating stage is connected and the type of stage,

then click the [Apply] button.
2. Re-connect the stage to the computer. If the stage moves slightly, it indicates that the stage is recognized.
3. If an error message “Turntable not found” appears, turn OFF the power to the stage, turn it ON again, and repeat

the steps from 1.

6 Select a scan mode.
In the [Camera1] tab page, click the [Fine] or [Fast] radio button.

<Settings>
• Fast: Scans the image in approximately 0.3 seconds. However, the number of pixels will drop to approximately

1/4 of that taken in Fine scan mode.
• Fine: Produces an image with a resolution of 640 × 480.

7 From the [General] tab, click the [Scan] button.
Scan will start, and both color and range images will be
displayed. The “Next angle: xx degree” message dia-
log box will also appear.

8 Click the [OK] button.
The turntable will turn to that angle, and then the object
will be scanned for the next image.

9 Repeat step 8 until shots from all the desired
angles are captured.
When shots from all the desired angles are captured,
the [Scan the chart? The turntable will be move.] mes-
sage dialog box will appear.

Click the [OK] button. The rotating stage will start to
rotate toward the angle (home position) where the cal-
ibration chart is to be measured. 
When the rotating stage has reached that angle (home
position), the “Scanning the Calibration Chart.” dialog
box will appear.



Importing Image Data
10 Place the calibration chart on the rotating ta-
ble.

11 Click the [OK] button.

12 Click the [Convert] button.
The [Remote-Convert] dialog box will appear.

13 Enter the desired element name, and click the
[OK] button.
The “Proceed to registration?” massage dialog box
will appear.

Note

The element name must consist of up to 31 alphanumeric
characters.

• If the [Save CDM] checkbox is checked, the
[Remote-Save] dialog box will appear.
1 Enter a file name.
2 Click the [Save] button.

Note

The file name must consist of alphanumeric characters
only.

14 Click the [OK] button.
Registration of elements will be fine-adjusted, and all the registered elements will appear.

Memo

The element name specified at step 13 will appear together with the rotation angles in the element list.
11
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Importing Image Data
Opening a Saved Data File
To open element or scene files saved on the computer, follow the procedure given below.

• For the method of saving element and scene files, refer to page 26.
• For details of the File – Open command, refer to page 24, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]

1 Click [Open] on the [File] menu.
The [File-Open] dialog box will appear.

2 From the “Look in” pull-down menu, select
the folder in which the file to be opened is
stored.

3 From the “File of type” pull-down menu, spec-
ify the type of file to be opened.

<Settings>
• Element files:Displays element files (.vvd).
• Scene Files: Displays scene files (.scn).

4 Click the file to be opened.
The file will be selected.

Memo

In the case of element files, it is possible to select two or more. To select them, click them while holding down the
[Shift] or [Ctrl] key.

5 Click the [Open] button.
The data of the selected file(s) will be imported and displayed in the screen.

Note

In the case of scene files, only one can be opened. If elements have already been imported before opening a
scene file, a dialog box will appear asking you whether to delete the elements.
To continue to import a scene file, click the [OK] button.

Ref.



Changing the Element View Mode
This section explains how to change the way elements are displayed to facilitate selection of points and process-
ing/editing of data. 

Displaying Points
Vertices of each element can be displayed. 
By default, vertices are hidden. If you want to show them, change the setting as follows.

For a description of how to Show Vertex/Hide Vertex, refer to the Polygon Editing Software Manual (page 206).

[Operating Procedure]

1 Click the right mouse button on a view win-
dow while holding down the [Ctrl] key. A pop-
up menu will appear.

2 From the pop-up menu, click [Show Vertex].
The vertices will be shown.

Memo

If vertices are already shown, [Show Vertex] is currently se-
lected. 
By default, F9 is assigned as the shortcut key for this func-
tion.

Ref.
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Changing the Element View Mode
Zoom
To enlarge or reduce the element displayed in an element window, follow the procedure given below.

For details of the View – Zoom command, refer to page 103, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]

1 Click [Zoom] on the [View] menu.
View – Zoom mode will be active.

Memo

To cancel the View – Zoom mode, select the View – Zoom
command again.

2 To enlarge the element, click the left mouse
button in the element window and drag the
mouse upward.

Memo

The data displayed while dragging the mouse is simplified
display data. 

For recalculation of simplified display data, refer to
page 141, in the Polygon Editing Tool Instruction
Manual.

3 To reduce the element, click the left mouse
button in the element window and drag the
mouse downward.

Ref.

Ref.



Changing the Element View Mode
4 To move the camera, click the right mouse
button in the element window and drag the
mouse in the desired direction.

For a description of the camera, refer to page 101, in the
Polygon Editing Tool Instruction Manual.

Orbit
To rotate the element displayed in an element window, follow the procedure given below.

Note

This command is effective only for the “Perspective” or “Isometric” element window.

For details of the View – Orbit command, refer to page 94, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]

1 Click [Orbit] on the [View] menu.
View – Orbit mode will be active.

Memo

• Usually, this operation is not required, because View –
Orbit mode is active in the initial condition. However, it is
necessary to click [Orbit] if View – Orbit mode is not ac-
tive.

• To cancel the View – Orbit mode, select the View – Orbit
command again.

2 Click the left mouse button in the “Perspec-
tive” or “Isometric” element window and drag
the mouse in the desired direction. The ele-
ment will rotate in the direction in which the
mouse is dragged.

Memo

The data displayed while dragging the mouse is simplified
display data.

For recalculation of simplified display data, refer to
page 141, in the Polygon Editing Tool Instruction
Manual.

Ref.

Ref.

Ref.
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Changing the Element View Mode
Switching the Rendering Mode
To switch the rendering mode for the element, follow the procedure given below. 

For a description of rendering mode, refer to the Window – Property command (page 182), in the Polygon Editing
Tool Instruction Manual.

[Operating Procedure]

1 Click the element window for which you want to change the rendering mode.

2 Click the  tool button.
The element will be displayed in wireframe mode.

3 Click the  tool button.
The element will be displayed in shading mode.

4 Click the  tool button.
The element will be displayed in texture-mapping
mode.

Ref.



Selecting the Item to be Processed/Edited
This section explains how to select the elements or points to be processed/edited.

Selecting an Element
If two or more elements have been imported, select the target element from the element list.

[Operating Procedure]

1 Check the checkbox of the desired element
name in the element list.
The selected element will be displayed in an element
window.

Memo

If  is clicked to clear the check mark, the element will not
be displayed.

2 Click the desired element name in the element
list to highlight it.
The element will be selected.

Memo

To select two or more elements, click their names while
holding down the [Shift] or [Ctrl] key.
17
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Selecting the Item to be Processed/Edited
Displaying Points
To process/edit an element, display its points so that you can see which points have been selected.

For details of the Window – Property command, refer to page 182, in the Polygon Editing Tool Instruction Man-
ual.

[Operating Procedure]

1 Click the element window where points are to be displayed.
The clicked element window will be active.

2 Click [Property] on the [Window] menu.
The [Property Dialog] dialog box will appear.

3 Click the [Show Points] checkbox in “Display”
section to place a check mark.

4 Click the [Apply] button.
Points will be displayed in the element window.

5 Click the [OK] button.
The [Property Dialog] dialog box will disappear.

Ref.



Selecting the Item to be Processed/Edited
Canceling the Selected Points
To cancel the currently selected points, follow the procedure given below.

For details of the Select – Unselect by Elements command, refer to page 125, in the Polygon Editing Tool Instruc-
tion Manual.

[Operating Procedure]

1 Click [Unselect by Elements] on the [Select]
menu.
The currently selected points will all be unselected
(displayed in blue).

Reversing the Selection state of Points
To reverse the selection state of points of the currently selected element(s), follow the procedure given below.

For details of the Select – Toggle Points command, refer to page 123, in the Polygon Editing Tool Instruction
Manual.

[Operating Procedure]

1 Click [Toggle Points] on the [Select] menu.
The currently selected points will be unselected (i.e.
displayed in blue), and the currently unselected points
will be selected (I.e. displayed in red).

Ref.

Ref.
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Selecting the Item to be Processed/Edited
Selecting Points within the Specified Rectangle Area
To select the points to be processed/edited within the specified rectangle area, follow the procedure given below.

Note

For the element window in which the selected points are to be edited, make sure that necessary settings to display points
are made.

For details of the Select – Rectangle command, refer to page 116, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]

1 To facilitate selection of points, enlarge or ro-
tate the target element.

For a description of changing the element view
mode, refer to page 13.

2 Click [Rectangle] on the [Select] menu.
Select – Rectangle mode will be active.

Memo

When the view mode is switched from one to another (e.g.
to Select – Rectangle mode), menus and icons will be inval-
idated and selection of commands is not possible until the
mode is cancelled.

3 Click the left mouse button at the desired start
position, drag the mouse to the desired end
position, and then release the mouse button.
A rectangle will be drawn, and all the points present in
the rectangle will be selected (displayed in red).

Memo

Clicking the right mouse button and dragging the mouse to
draw a rectangle will cause all the points present in the rec-
tangle to be unselected (i.e. will be displayed in blue).

4 Repeat step 3 until all the desired points are
selected.

5 Press the [ESC] key.
Select – Rectangle mode will be cancelled.

Ref.

Ref.



Processing/Editing Data
This section explains how to process/edit the currently selected elements or points.

Deleting Points
To select and delete unnecessary points, follow the procedure given below.

For details of the Edit – Delete – Points command, refer to page 130, in the Polygon Editing Tool Instruction Man-
ual.

[Operating Procedure]

1 Select the unnecessary points.

For a description of how to select points, refer to
page 20.

2 From the [Edit] menu, select [Delete] and then
click [Points].
The selected points will be deleted.

Ref.

Ref.
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Processing/Editing Data
Performing Registration of Elements
To designate corresponding points of the elements obtained when the same object was scanned from different
angles without the turntable, follow the procedure given below.

For details of the Build – Registration – Initial – Manual command, refer to page 143, in the Polygon Editing Tool
Instruction Manual.

[Operating Procedure]

1 Select the desired two elements from the ele-
ment list.

For a description of selecting elements, refer to
page 17.

2 From the [Build] menu, select [Registration],
[Initial] and then click [Manual].
The [Build-Registration-Initial-Manual] dialog box
will appear.

3 Select the basis element (i.e. the element to be
used as the reference element for registra-
tion), and click the [OK] button.
Build – Registration – Initial – Manual mode will be
active, and the both of elements will be texture-
mapped.

Memo

When the view mode is switched from one to another (e.g.
to Build – Registration – Initial – Manual mode), menus and
icons will be invalidated and selection of commands is not
possible until the mode is cancelled.

4 Click the corresponding points in each ele-
ment window with the left mouse button.
A marker (  mark) will be displayed for each clicked
corresponding point.

Ref.

Ref.



Processing/Editing Data
5 Repeat step 4 until more than three pairs of corresponding points are designated for the
desired elements.

Memo

Since the order of designating corresponding points is not fixed, designation can be started from any window.

6 Click the right mouse button.
The initial registration will start, and the result will be
displayed. A message dialog box will also appear ask-
ing whether the result is satisfactory.

Memo

If the registration result is not satisfactory, click the [Retry]
button to return to step 4.

7 Click the [OK] button.
The initial registration will end, and a dialog box will
appear, allowing you to check the results.

Memo

• Pressing the [Repeat] button will perform fine-adjust-
ment.

• The values shown in Error Average and Sigma are guide-
lines to help you know how well registration is performed. 
The closer to zero they are, the more accurate registration is.

8 Click the [OK] button.
Build – Registration – Initial – Manual mode will be
cancelled, and registration of elements is now com-
plete.
23
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Processing/Editing Data
Merging Elements
To merge the registrated elements to create a new element, follow the procedure given below.

For details of the Build – Merge command, refer to page 161, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]

1 Select the desired elements from the element
list.

For a description of selecting elements, refer to
page 17.

2 Click [Merge] on the [Build] menu.
The [Build-Merge] dialog box will appear.

3 Click the [OK] button.
A dialog box will appear, allowing you to enter a new
element name.

4 Enter the desired name for the new element to
be created, and click the [OK] button.
The elements will be merged and a new element will
be created.

Note

The element name must consist of up to 31 alphanumeric
characters.

Ref.

Ref.



Processing/Editing Data
Undo
To cancel the previous operation and return to the state in effect before the previous operation was performed,
follow the procedure given below.

For details of the Edit – Undo command, refer to page 128, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]

1 Click [Undo] on the [Edit] menu.
The previous operation will be cancelled, and the state in effect before the previous operation was per-
formed will be restored.

Note

The Undo function is not effective for some commands and operations.

Redo
To perform the operation that has been canceled by the Edit – Undo command, follow the procedure given be-
low.

For details of the Edit – Redo command, refer to page 128, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]

1 Click [Redo] on the [Edit] menu.
The operation which has been canceled by Undo will be performed.  

Ref.

Ref.
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Saving Data
This section explains how to save the data which has been imported to the Polygon Editing Tool.

Saving Elements
To save the data selected in the element list as an element file (.vvd), follow the procedure given below.

For details of the File – Save – Elements command, refer to page 26, in the Polygon Editing Tool Instruction Man-
ual.

[Operating Procedure]

1 From the element list, select the elements to be saved by clicking them.

For a description of selecting elements, refer to page 17.

2 From the [File] menu, select [Save] and then
click [Elements].
The [File-Save-Elements] dialog box will appear.

Memo

If the selected element data is that of an element file that has
been imported, the data will be overwritten. No dialog box
will be displayed.

3 From the “Save in” pull-down menu, select the folder to which the file is to be saved.

4 Enter the desired file name, and click the [Save] button.
The element data will be saved.

Note

The file name must consist of alphanumeric characters only.

Ref.

Ref.



Saving Data
Saving a Scene
The currently opened elements and their view information (zoom setting, viewing direction, view mode) can
be saved as a scene file (.scn). When you want to save the current state before or during starting processing/
editing data, save the scene file as explained below.

For details of the File – Save – Scene command, refer to page 27, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]

1 From the [File] menu, select [Save] and then
click [Scene].
The [File-Save-Scene] dialog box will appear.

Memo

If the currently opened data is that of a scene file that has
been imported, the data will be overwritten. No dialog box
will be displayed.

2 From the “Save in” pull-down menu, select the folder to which the file is to be saved.

3 Enter the desired file name, and click the [Save] button.
The scene data will be saved.

Note

The file name must consist of alphanumeric characters only.

Ref.
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Saving Data
Converting to Other Formats
To convert the data selected in the element list to other data formats, follow the procedure given below.

For details of the File – Export – Elements command, refer to page 90, in the Polygon Editing Tool Instruction
Manual.

[Operating Procedure]

1 From the [File] menu, select [Export] and then
click [Elements].
The [File-Export-Elements] dialog box will appear.

2 From the “Export in” pull-down menu, select the folder to which the converted file is to
be saved.

3 Enter the desired file name.

Note

The file name must consist of alphanumeric characters only.

4 From the “File as type” pull-down menu, select the data format in which the file is to be
converted.

5 Click the [Export] button.
The data will be saved in the selected file format.

Ref.



Operation Tips
This section gives some examples of data processing/editing using this Polygon Editing Tool. 

Case 1
To scan an object using the turntable and save the acquired data in a DXF file, follow the procedure given be-
low.

[Operating Procedure]

1 Perform step scan.

For basic operation of the File – Import – Digitizer – Step Scan command, refer to page 9. For a detailed
explanation, refer to page 59, in the Polygon Editing Tool Instruction Manual.

2 Merge the desired elements to one element.

For basic operation of the Build – Merge command, refer to page 24. For a detailed explanation, refer to
page 161, in the Polygon Editing Tool Instruction Manual.

3 Convert the merged element data to the desired format.

For basic operation of the File – Export – Elements command, refer to page 28. For a detailed explanation,
refer to page 91, in the Polygon Editing Tool Instruction Manual.

Ref.

Ref.

Ref.
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Case 2
To scan an object a few times because its data cannot be acquired by one scan and save the imported elements
after deleting unnecessary parts from them, follow the procedure given below.

[Operating Procedure]

1 Perform one scan as many times as you need.

For basic operation of the File – Import – Digitizer – One Scan command, refer to page 7. For a detailed
explanation, refer to page 54, in the Polygon Editing Tool Instruction Manual.

2 Perform registration of the desired elements.

For basic operation of the Build – Registration – Initial – Manual command, refer to page 22. For a detailed
explanation, refer to page 143, in the Polygon Editing Tool Instruction Manual.

3 Merge the elements to one element.

For basic operation of the Build – Merge command, refer to page 24. For a detailed explanation, refer to
page 161, in the Polygon Editing Tool Instruction Manual.

4 Change the view mode so that unnecessary parts of the data can be easily selected.

• For basic operation of the View – Zoom command, refer to page 14. For a detailed explanation, refer to
page 103, in the Polygon Editing Tool Instruction Manual.

• For basic operation of the View – Orbit command, refer to page 15. For a detailed explanation, refer to
page 102, in the Polygon Editing Tool Instruction Manual.

5 Display points in the element windows.

For basic operation of the Window – Property command, refer to page 18. For a detailed explanation, refer
to page 190, in the Polygon Editing Tool Instruction Manual.

6 Select the unnecessary points.

• For basic operation of the Select – Unselect by Elements command, refer to page 19. For a detailed ex-
planation, refer to page 125, in the Polygon Editing Tool Instruction Manual.

• For basic operation of the Select – Toggle Points command, refer to page 19. For a detailed explanation,
refer to page 123, in the Polygon Editing Tool Instruction Manual.

• For basic operation of the Select – Rectangle command, refer to page 20. For a detailed explanation,
refer to page 116, in the Polygon Editing Tool Instruction Manual.

Ref.

Ref.

Ref.

Ref.

Ref.

Ref.
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7 Delete the selected points.

For basic operation of the Edit – Delete – Points command, refer to page 21. For a detailed explanation,
refer to page 130, in the Polygon Editing Tool Instruction Manual.

8 Saves the elements.

For basic operation of the File – Save – Elements command, refer to page 26. For a detailed explanation,
refer to page 26, in the Polygon Editing Tool Instruction Manual.

Ref.

Ref.
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Case 3
With some objects, their entire image data cannot be acquired even by Step Scan, because of their shape. In
addition, to acquire complete 3D data by scanning the top and bottom surfaces of the object, scan must be re-
peated and each data must be merged after registration.

[Operating Procedure]

1 Perform step scan around the object.

For basic operation of the File – Import – Digitizer – Step Scan command, refer to page 9. For a detailed
explanation, refer to page 59, in the Polygon Editing Tool Instruction Manual.

2 Change the view mode so that unnecessary parts of the data can be easily selected.

• For basic operation of the View – Zoom command, refer to page 14. For a detailed explanation, refer to
page 104, in the Polygon Editing Tool Instruction Manual.

• For basic operation of the View – Orbit command, refer to page 15. For a detailed explanation, refer to
page 103, in the Polygon Editing Tool Instruction Manual.

3 At the angles that did not produce sufficient scan at step 1, repeat one scan as many
times as needed.

For basic operation of the File – Import – Digitizer – One Scan command, refer to page 7. For a detailed
explanation, refer to page 54, in the Polygon Editing Tool Instruction Manual.

4 Perform registration of the elements acquired at steps 1 and 3.

For basic operation of the Build – Registration – Initial – Manual command, refer to page 22. For a detailed
explanation, refer to page 143, in the Polygon Editing Tool Instruction Manual.

5 Merge the elements to one element.

For basic operation of the Build – Merge command, refer to page 24. For a detailed explanation, refer to
page 161, in the Polygon Editing Tool Instruction Manual.

6 Re-position the object, and perform one scan on its top and bottom surfaces.

For basic operation of the File – Import – Digitizer – One Scan command, refer to page 7. For a detailed
explanation, refer to page 54, in the Polygon Editing Tool Instruction Manual.

Ref.

Ref.

Ref.

Ref.

Ref.

Ref.
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7 Perform registration of the element merged at step 5 and that scanned at step 6.

For basic operation of the Build – Registration – Initial – Manual command, refer to page 22. For a detailed
explanation, refer to page 143, in the Polygon Editing Tool Instruction Manual.

8 Merge the elements to one element.

For basic operation of the Build – Merge command, refer to page 24. For a detailed explanation, refer to
page 161, in the Polygon Editing Tool Instruction Manual.

9 Saves the element.

For basic operation of the File – Save – Elements command, refer to page 26. For a detailed explanation,
refer to page 26, in the Polygon Editing Tool Instruction Manual.

Ref.

Ref.

Ref.
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Case 4
To scan objects from one to another continuously and effectively under the same conditions using the bench
top frame set, follow the procedure given below.

[Operating Procedure]

1 Assemble the bench top frame set and mount the VIVID 910 on it.

For details of the assembly method for the bench top frame set, refer to its instruction manual. 

2 Scan the first object in step scan mode.

Memo

Make sure that the calibration chart data is saved.

For details of how to use the File – Import – Digitizer – Step Scan command with the bench top frame set,
refer to page 64, in the Polygon Editing Tool Instruction Manual.

3 Save the elements.

For basic operation of the File – Save – Elements command, refer to page 26. For a detailed explanation,
refer to page 26, in the Polygon Editing Tool Instruction Manual.

4 Place the next object on the rotating stage and perform step scan.

For details of operation of the File – Import – Digitizer – Step Scan command, that performs scanning au-
tomatically using the bench top frame set, refer to page 70 in the Polygon Editing Tool Instruction Manual.

5 Save the elements.

For basic operation of the File – Save – Elements command, refer to page 26. For a detailed explanation,
refer to page 26, in the Polygon Editing Tool Instruction Manual.

6 Repeat steps 4 and 5 until all the remaining objects are scanned.

Ref.

Ref.

Ref.

Ref.

Ref.
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Easy Align
Easy Align
Align and Import Data from Multiple Scans
Adhere markers to the object to be scanned, and then take multiple scans at different angles. You can then align
and import the data from these scans.

For information about the File – Import – Digitizer – Easy Align command, refer to page 82, in the Polygon Ed-
iting Tool Instruction Manual.

To use the Easy Align feature you must connect up a VIVID 910/VI-910.

Starting Easy Align
In order to use this function, start Easy Align from the Polygon Editing Tool.

The Easy Align software is incorporated in the Polygon Editing Tool so there is no need to install it separately;
however, a license is necessary to use all of its features. In addition, it is necessary that the VIVID 910/VI-910
be connected to the PC until Easy Align has finished starting up.

[Operating Procedure]

1 From the [File] menu, select [Import] – [Digitizer]
and click [Easy Align].
The program opens a temporary window in the upper
half of the main window. If this is the very first time
you have executed this command (and if a VIVID 910/
VI-910 is connected), the program will display the “Li-
cense failure.” warning dialog. This is because you have
not yet entered your license code.

Memo

If you are using the command for the first time but you have not connected a VIVID 910/VI-910, the program will
display a warning dialog informing you that there is no VIVID 910/VI-910 connected. In this case the program will
not display a “License failure.” warning, and you will be able to continue to subsequent steps of the procedure with-
out entering a license code. But because you have not entered the license code, you will not be able to make any
use of the final aligned data.

• If the program has already verified your license, it opens the [File-Import-Digitizer-Easy Align]
dialog. 

2 Click the [OK] button.
If a VIVID 910/VI-910 is connected, the program
opens the license-code entry dialog.

Ref.

Memo

Memo



Easy Align
3 Enter the license code that you have obtained, and then click the [OK] button.
The program opens the [File-Import-Digitizer-Easy Align] dialog.
• The left window in the dialog (the “work window”) displays the image captured by the VIVID

910/VI-910, in monochrome. The right window (the “store window”) does not yet display an-
ything.

Note

If you entered an incorrect license code, or if you canceled the license-code entry process, the [Convert] button will
not be enabled on the dialog. This means that you will not be able to make use of the aligned data.

VIVID 910/VI-910 Calibration
In the Easy Align, position alignment is carried out based on the marker information gotten from the markers
affixed to the object to be measured. Adjustment is carried out by implementing calibration of the White Bal-
ance adjustment and Color Chart under the same lighting conditions as those used for the actual scan in order
to get stable and correct marker information.

Warning
Never look directly into the laser-emitting window.
Never place lenses, optical elements, or  mirrored surfaces in the path of the laser beam, as such
objects may deflect or concentrate the beam, resulting in eye damage, fire, or burns. To prevent the
beam from accidentally making contact with such objects, be sure that there is a wall or opaque
backdrop behind the subject to block the beam from further travel.

In performing VIVID 910/VI-910 calibration, always be sure to attach the same lens that will be used during the
actual scan of the object to be measured.

[Operating Procedure]

4 Adjust the white balance on the VIVID unit, and check the light source.
Because the Easy Align command must automatically detect the markers adhered to the scanned object, lighting
conditions are of critical important. This means that it is necessary to adjust the white balance at the VIVID unit
before using the command, and it is important to keep the illumination conditions constant during measurements.

Note

The Easy Align command cannot be used if you are working near a window exposed to the midday sun, or if
you are using a tungsten-color fluorescent light source.

Memo
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Memo

The recommended light source is a daylight-colored fluorescent lamp with a brightness that is appropriate for a
typical office environment (about 500 lux).

Ref.

For information about how to carry out white-balance adjustment, refer to page 43, in the VIVID unit’s Instruction
Manual.

5 Click the [Parameters] tab.

6 Click the [Settings] button.
The name of the button changes to [Calibration]. 

Note

The [Settings] button does not appear if [Auto Marker Detection] checkbox is unchecked.

7 Place the supplied color chart same position
as the object to be scanned. 
Set the lighting to the same conditions you will use
when carrying out the actual scan. Set the color chart so
that it is directly facing the VIVID 910/VI-910 lens. 

Note

It is important to set this up so that you will scan only the
color chart and nothing else. Check the image display in
the dialog (see illustration below) to make sure that the
scan will cover the color chart only. 

8 Click the [Calibration] button.
The program executes calibration so as to improve the
accuracy of marker detection. If calibration is success-
ful, the “Calibration success.” dialog appears.

• If calibration is not successful, the “Calibration
failure.” dialog appears. If this happens, click the
dialog’s [OK] button and return to Step 4. Adjust the lighting conditions, the imaging param-
eters, and the positioning as appropriate, and then try calibration again. 

9 Click the [OK] button.
The dialog closes. This completes the calibration.

Color chart



Easy Align
Scanning Preparations
Attach the markers, decide on the image angle and select Scan Mode so that automatic alignment of the scan
data can be carried out by Easy Align.

[Operating Procedure]

10 Adhere the markers onto the object.
Markers are available in three sizes: S, M, and L. Select the appropriate size based on the object’s size,
the lens your are using, and the measurement distance. Attach markers at appropriate intervals, in ac-
cordance with the marker spacing values indicated in the table below. 

Memo

To obtain precise alignment when carrying out the Easy
Align command, the program must correctly recognize at
least three markers on each scan. Furthermore, for any two
successive scans taken at different angles, the program must
recognize at least three common markers (i.e., it must recog-
nize at least three matching marker IDs). Keep these require-
ments in mind when adhering the markers, and adhere as
many markers as practicable. If it is not possible to stick
markers directly on the object, or if you are taking repeated
scans of similar objects, a convenient alternative is to place
the object on a pedestal and stick the markers onto the pedes-
tal rather than the object. Then scan the pedestal together
with the object.

11 Adjust the position of the object and move the
VIVID 910/VI-910 forward or back as necessary
to get the right viewing angle, so that the ob-
ject appears at the center of the display.
The [Mono] radio button in the dialog should be On, so
that you can check the viewing angle on the screen
while setting up the object. (If you are checking the
view by through the VIVID 910/VI-910 viewfinder,
however, then you should set the [Color] radio button
On.)

Note

Set the object and the VIVID unit so that at least three
markers are visible.

12 Click the [Scan Mode] tab.

Measured range
(H × V)

Lens and Distance
Marker size Marker spacing

Telephoto lens Mid-size lens
200 × 150 mm less than 1200 mm less than 600 mm S ( φ 9 mm) 50 mm
400 × 300 mm less than 2500 mm less than 1200 mm M ( φ 15 mm) 100 mm
640 × 480 mm – less than 2000 mm L ( φ 21 mm) 200 mm
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13 Select the scan mode by clicking the appropriate button: either [FINE] or [FAST].

<Settings>
• Fast: Enables fast scans (about 0.3 second per scan), but image resolution is only about 1/4 the resolution that

you get with Fine mode.  
• Fine: Image resolution of 640 × 480

Executing Easy Align
The object to be measured is scanned and the data is then aligned and fetched.

When scanning, always be sure to use the same lens that was used when the VIVID 910/VI-910 calibration was
carried out.

Warning
Never look directly into the laser-emitting window.
Never place lenses, optical elements, or  mirrored surfaces in the path of the laser beam, as such
objects may deflect or concentrate the beam, resulting in eye damage, fire, or burns. To prevent the
beam from accidentally making contact with such objects, be sure that there is a wall or opaque
backdrop behind the subject to block the beam from further travel.

[Operating Procedure]

14 Click the [Scan] button to carry out the first
scan.
The program takes the scan and displays the resulting
color image in the work window on the left of the dia-
log. It also automatically detects the markers, and dis-
plays a single character (0 to 9 or A to Y) for each
“marker ID” (0 to 34) in each location at which a mark-
er was detected.
If the scanned data is good enough for alignment
processing, the condition bar (under the work window)
becomes blue (Good condition), indicating that the con-
ditions are good. If the scan results are not good enough
for alignment, the condition bar turns red (No good), in-
dicating that the setup is not good. For the first scan, the
bar will be blue if the program successfully detected at
least three markers; otherwise the bar will be red.

Memo

On the color image, areas that have no distance data are displayed as black.

• If you have checked the [Auto] checkbox (above the [Store] button) and if conditions are good
(if the bar is blue), the program will automatically continue processing up through Step 16.

• If the program fails to detect at least three markers, the condition bar will be red. In this case,
recheck the lighting conditions, the marker orientations, and the size, and then take the scan
again. If necessary, return to Step 4 and start again from calibration.

Note

If the [Auto Marker Detection] checkbox is unchecked, the program will not carry out automatic marker detec-
tion. 

Memo
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15 If necessary, adjust the marker correspondences.
• If any of the detected marker IDs does not match the corresponding marker on the actual ob-

ject, correct as follows: right-click the marker ID on the image, and then enter the correct
marker ID at the dialog that opens.

• If any of the marker IDs displayed on the stored image (the image stored at Step 16 below)
does not match the corresponding marker ID displayed on the image scanned at Step 14
above, correct as follows: Left-click the mismatched ID in either of these two images, and
then left-click on the correct corresponding marker ID in the other image. The program will
change the IDs so that they are identical.

• To set up a “new” marker ID on images from Step 14 and Step 16 in a location where there
was no physical marker on the object (or where the program failed to detect a marker), left-
click the corresponding points in the two images. The program will set a marker ID of “ *” at
these points.

Note

If the condition bar (under the work window) is red, this means that the data is not yet suitable for alignment.
Adjust the marker correspondences and take other steps as necessary until the bar becomes blue.

16 Click the [Store] button.
The data displayed in the work window moves over into the store window on the right side of the dialog.
Marker detection results continue to be indicated in the condition bar. The temporary window displays
the data in 3D.

17 Change the angle of the object, and click the [Scan] button to take the second scan.
The program executes the scan and automatically detects the markers. 
For this second scan and for all subsequent scans, the results will be good (the bar will be blue) if the
program detects at least three of the markers that are already displayed in the 3D image in the temporary
window. 
• If you have checked the [Auto] checkbox (above the [Store] button) and if conditions are good

(if the bar is blue), the program will automatically continue processing up through Step 19.
When you first runs the command, [Auto] checkbox is unchecked. We recommend, however,
that you turn [Auto] on by checking the box.

18 If necessary, adjust the marker correspondences.
• If any of the detected marker IDs does not match the corresponding marker on the actual ob-

ject, correct as follows: right-click the marker ID on the image, and then enter the correct
marker ID at the dialog that opens. 

• If any of the marker IDs displayed on the image stored at Step 16 does not match the corre-
sponding marker ID displayed on the image scanned at Step 17, correct as follows: Left-click
the mismatched ID in either of these two images, and then left-click on the correct corre-
sponding marker ID in the other image. The program will change the IDs so that they are iden-
tical.

• You can also set up a new marker ID on both images (the image from Step 16 and the image
from Step 17) in a location where the program failed to detect a marker (or where no marker
was present). To do this, left-click the corresponding points in the two images. The program
will add a new marker at these points. 
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Note

If the condition bar (under the work window) is red, this means that the data is not suitable for alignment. Adjust
the marker correspondences as necessary to get a blue bar.

19 Click the [Store] button.
The data from the second scan moves into the store window, and is aligned with the data that was already
displayed. The temporary window shows a preliminary converted image (“pre-converted” image) of all
of the stored data.

20 Repeat steps 17 to 19 as necessary to scan at all desired angles.
• You can use the [<<Prev] button or [Next>>] button to move through the stored-data displays.
• You can use the [Delete] button to delete unnecessary stored data.

21 If you have adjusted the marker correspondences, click the [Pre-Convert] button.
The image displayed in the store window is realigned based on the change in the marker correspondence,
and the result appears in the temporary window.

22 Click the [Convert] button.
The program opens the [File-Import-Digitizer-Easy
Align-Convert] dialog.
• If you do not enter the correct license code at

Step 2, the [Convert] button will not be enabled.

23 Enter a name for the element, and click the
[OK] button.
The temporary window (the window that was showing
the pre-converted image) closes. The program converts
the data that was displayed in the store window, and
displays the resulting aligned data.

Note

Enter an element name of up to 31 alphanumeric characters.

• If the [Save Data] checkbox was checked, the program opens the [Save Data] dialog.
1 Enter a filename for the file to be saved.
2 Click the [Save] button.

Note

The filename must be alphanumeric characters only. 
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